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 The Provider Dashboard is only accessible to users logged in at the level of Administrator 
or NOC Operator.  From this Dashboard, global information and configuration options are 

available for all of a Service Provider’s installed customers and all registered users. 

 

DASHBOARD   

 No Menu Options Clicking on this menu bar item refreshes and displays the Provider Dashboard. 

 

TOOLS   

 Manage Customers 

Displays the list of all active customers and provides a link for adding new customers.  
Links are also provided for modifying the “Customer Details” of each listed customer and 
for deleting a customer’s installation from the system entirely. 

Note 1: The Service Provider’s own installation cannot be deleted. 

[ This menu option is not available to NOC Operators. ] 

 Manage Users 

Displays the current list of active users along with the specific customer each user is 
associated with and the user’s authorization level.  Also, allows passwords to be 
changed, existing users to be deleted, and new users to be added.  

Note 1: NOC Operators are not allowed to delete or change the password of an 
Administrator. 

 Message Editor 

Allows the text and format of content in the Portal Message Box to be entered and 
modified.  Text characters and HTML formatting tags up to a combined limit of 250 
characters are accepted.  (Note, however, that enlarging the text font size may limit the 
number of characters that can be displayed within the Portal Message Box itself.) 

[ This menu option is not available to NOC Operators. ] 

 

REPORTS   

 Monitors 
Shows the total number of installed monitors along with a list (by monitor name) and the 
count of each installed monitor.  

 Notifications 
Lists the history of alerts for all customers as a group and for every customer individually.  
Drill-down detail is available for the 50 most recent alerts as well as for alerts generated 
during the previous 48 hours, 7 days, 30 days, and 60 days. 

 Customers 

Provides a list of all installed customers along with related information, including:  

• Address – City – State – ZIP – Email – Phone 

• Customer Since (Date) – Contract Expiration (Date) 

 Deployed Assets 

Provides a top-down summary of all Nortel Network devices (from the BCM and VPN 
Router product lines) that are installed in the system, with drilldown access to specific 
inventory details by “Version” and “Customer”.  

Note 1: This menu option is only available when MSOvoip is enabled in the system. 

 
 
 



MSOware Service Provider – Menu Guide Ver. 1.4 
 

 

PROVIDER Dashboard 
 

MSOware_Menu-Guide_JAN-07a.doc Page 2 of 7 2/1/2007 
 

Copyright 2006-2007 Pandetix, LLC – Confidential & Proprietary 

 

REPORTS . . . continued  

 Access Log 

Lists the name of all Users that have logged into the system in the current month (resets 
at the end of the previous month) and the number of successful login attempts for each.  
Drilldown detail is available for each User which lists the Message, User IP Address, and 
Date/Time of every login. 

 

SETTINGS   

 Notify Settings 

Allows details of the notification procedure to be entered and modified.  Fields are: 

• SMTP Server Name – Format is: smtp.mail.domain.com 

• Username – Leave blank if no SMTP authentication 

• Password – Leave blank if no SMTP authentication 

• Provider Name – Displayed as Service Provider on all notifications  

• From E-mail Address – Used as path for e-mail replies and returns 

• From Name – Displayed in “From” field of all notifications 

• From Subject Line – Displayed in “Subject Line” field of all notifications 

• Notify Body Mail – Name of text file containing notification content 

[ This menu option is not available to NOC Operators. ] 

 Request Settings 

Allows details of the “Help > Request Information” procedure (accessible in Customer 
Portals) to be entered and modified.  Fields are: 

• Request: Send To Address – Used as the “To” path for e-mail information requests 
created by users from within a Customer Portal 

• Request: Subject Line – Used as the “Subject Line” of e-mail information requests 

• Request: Form Text – Allows the text and format of content displayed on the 
“Request Information Form” to be entered and modified.  Text characters and HTML 
formatting tags up to a combined limit of 250 characters are accepted.  

[ This menu option is not available to NOC Operators. ] 
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SETTINGS . . . continued  

 Provider Details 

Allows the Service Provider’s contact details and other information to be entered and 
modified.  Fields are: 

• Customer Name – [ Required Field ] The name of the Service Provider.  The content 
of this field appears on the Provider and Portal Dashboards as the “Provider:” 

• Customer Number – [ N/A ] 

• Contact First Name – [ N/A ] 

• Contact Last Name – [ N/A ] 

• Contact Telephone – [ N/A ] 

• Contact E-mail – [ N/A ] 

• Street Address – [ N/A ] 

• City – [ N/A ] 

• State/Province – [ N/A ] 

• Country – [ N/A ] 

• ZIP/Postal Code – [ N/A ] 

• Notify E-mail – [ Required Field ] If no other e-mail addresses are specified for a 
customer, all alert notifications for that customer will be sent to this address. 

• Expiration Date – [ N/A ] 

• Comments – [ N/A ] 

• License – [ N/A ] 

Note 1: This is the same form that is used to add details for a new customer (Tools > 
Manage Customers > Add New > Customer Details) or modify existing information for 
existing customers (Tools > Manage Customers > Modify > Customer Details).  However, 
since the Service Provider is the “default customer” (which must exist for the system to 
operate correctly) the “Delete Customer” option on this form is nonfunctional. 

[ This menu option is not available to NOC Operators. ] 

 

SEARCH   

 Find Customer Allows a search for installed customers by Customer Name or Contact E-mail. 

 Find User  Allows a search for active users by Username. 

 

HELP   

 Menu Guide Accesses a copy of this Menu Guide in PDF format for display and/or printing. 

 Reference Provides details on the setup and operation of MSOware at the Service Provider level. 

 About Displays the MSOware copyright and other legal notices.   

 

LOGOUT   

 No Menu Options Clicking on this menu bar item immediately logs the user out of MSOware. 
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All of the menu options outlined below are accessible on the Portal Dashboard to users logged 
in at the level of Administrator or NOC Operator.  On this Dashboard, information and options 

are available regarding one specific customer and their related users.   

 

DASHBOARD   

 No Menu Options 

If the Portal Dashboard is NOT the current screen being displayed, clicking on this menu 
bar item refreshes and displays the Portal Dashboard.  If the Portal Dashboard is already 
being displayed, clicking on this menu bar item brings the user up to the level of the 
Provider Dashboard, which is refreshed and displayed. 

 

TOOLS   

 Add Monitor 
As long as the customer license limit is not exceeded, this menu option allows certain 
new monitors to be added.  

 

REPORTS   

 Monitors 
Shows the total number of installed monitors along with a list (by monitor name) and the 
count of each installed monitor. 

 Notifications 
Lists the history of alerts for all customers and installed devices.  Drill-down detail is 
available for the 50 most recent alerts as well as for alerts generated during the previous 
48 hours, 7 days, 30 days, and 60 days. 

 Device History Lists the history of alerts for a specific device over the last 7, 30 or 60 days (selectable). 

 Notify Details 
Lists all of the devices for which alerts are generated, along with information on the 
specific e-mail addresses that receive notifications. In addition, the structure, wording and 
content fields of e-mailed alerts is provided. 

 
Nortel BCM 
Inventory 

Lists all BCM devices installed under a specific customer’s portal with details on: 

• Device Name – Model – Serial Number. 

In addition, if supported by the version of software installed on a BCM device, the 
following information is also listed: 

• Software (SW) Version – (# of) Sets – (# of) Analog Lines – (# of) VoIP Trunks. 

Further drilldown reports are provided which list the Model, Serial Number, System ID, 
and Software Version for each BCM device along with the following additional details (if 
supported by the version of software installed on that device): 

• Schedule A: HW/SW/Keycode – (Keycode) Name & (Keycode) Feature Data; 

• Schedule A: Lines and Sets – Line, Trunk Type, Line Type, & Control Set. 

 Report Schedule 

Allows automated reporting to be scheduled on a daily, weekly and/or monthly basis for 
each installed element (a device/monitor combination) and e-mail recipient(s) of those 
reports to be designated.  Reports are generated and sent as follows: 

• If Daily – 2:28am every day 

• If Weekly – 3:28am on Saturday of every week 

• If Monthly – 4:28am on the first day of every month 
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SETTINGS   

 Customer Details Allows the customer’s contact information to be viewed and modified. 

 User Details 

Displays the current list of active users along with each user’s authorization level.  Also, 
allows passwords to be changed, existing users to be deleted, and new users to be 
added. 

Note 1: NOC Operators are not allowed to delete, or change the password of, an 
Administrator. 

 

SEARCH   

 Find Device Allows a search, by Device Name or Monitor Name, for installed devices or monitors. 

 

HELP   

 Quick Start Summarizes basic features of the system using screen shots and callouts. 

 Reference Describes the setup and operation of this system in detail. 

 
Request 

Information 
Displays a link for launching a new message (from the user’s default e-mail client) that is 
addressed to the Service Provider. 

 About Displays the system copyright and other legal notices.    

 

LOGOUT   

 No Menu Options Clicking on this menu bar item immediately logs the user out of MSOware. 
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Users logged in at the level of Portal Manager or Portal User only have access through the 
Portal Dashboard to their own devices, monitors and data.  On this Dashboard, the available 

menu options apply to one specific customer and their related users. 

 

DASHBOARD   

 No Menu Options Clicking on this menu bar item refreshes and displays the Portal Dashboard. 

 

TOOLS   

 Add Monitor 

As long as the customer license limit is not exceeded, this menu option allows certain 
new monitors to be added by a user logged in at the level of Portal Manager.  (Note: At 
the option of the Service Provider, this facility may be limited or unavailable.) 

[ This menu option is not available to Portal Users. ] 

 

REPORTS   

 Monitors 
Shows the total number of installed monitors along with a list (by monitor name) and the 
count of each installed monitor. 

 Notifications 
Lists the history of alerts for all installed devices.  Drill-down detail is available for the 50 
most recent alerts as well as for alerts generated during the previous 48 hours, 7 days, 
30 days, and 60 days. 

 Device History Lists the history of alerts for a specific device over the last 7, 30 or 60 days (selectable). 

 Notify Details 
Lists all of the devices for which alerts are generated, along with information on the 
specific e-mail addresses that receive notifications. In addition, the structure, wording and 
content fields of e-mailed alerts is provided. 

 
Nortel BCM 
Inventory 

Lists all BCM devices installed under a specific customer’s portal with details on: 

• Device Name – Model – Serial Number. 

In addition, if supported by the version of software installed on a BCM device, the 
following information is also listed: 

• Software (SW) Version – (# of) Sets – (# of) Analog Lines – (# of) VoIP Trunks. 

Further drilldown reports are provided which list the Model, Serial Number, System ID, 
and Software Version for each BCM device along with the following additional details (if 
supported by the version of software installed on that device): 

• Schedule A: HW/SW/Keycode – (Keycode) Name & (Keycode) Feature Data; 

• Schedule A: Lines and Sets – Line, Trunk Type, Line Type, & Control Set. 

 Report Schedule 

For each installed element (a device/ monitor combination), allows automated reporting 
to be scheduled on a daily, weekly and/or monthly basis and e-mail recipient(s) of those 
reports to be designated.  Reports are generated and sent as follows: 

• If Daily – 2:28am every day 

• If Weekly – 3:28am on Saturday of every week 

• If Monthly – 4:28am on the first day of every month 

[ This menu option is not available to Portal Users. ] 
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SETTINGS   

 Customer Details 
Allows the customer’s contact information to be viewed and modified.  

[ This menu option is not available to Portal Users. ] 

 User Details 

Displays the current list of active users along with each user’s authorization level.  Also, 
allows passwords to be changed, existing users to be deleted, and new users to be 
added.  

[ This menu option is not available to Portal Users. ] 

 

SEARCH   

 Find Device Allows a search, by Device Name or Monitor Name, for installed devices or monitors. 

 

HELP   

 Quick Start Summarizes basic features of the system using screen shots and callouts. 

 Reference Describes the setup and operation of this system in detail. 

 
Request 

Information 
Displays a link for launching a new message (from the user’s default e-mail client) that is 
addressed to the Service Provider. 

 About Displays the system copyright and other legal notices.    

 

LOGOUT   

 No Menu Options Clicking on this menu bar item immediately logs the user out of MSOware. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


